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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Dress-Up Features



Student Notes:



In this lesson you will learn how to place dress-up features on parts. Lesson Contents:



Copyright DASSAULT SYSTEMES



Case Study: Timing Chain Cover Design Intent Stages in the Process Apply a Draft Create a Stiffener Create Threads and Taps Edit Features



Duration: Approximately 0.5 day
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Case Study: Dress-Up Features



Student Notes:



Copyright DASSAULT SYSTEMES



The case study for this lesson is the Timing Chain Cover used in the Front Suspension and Engine assembly shown below. The Timing Chain Cover is part of the Power Train sub-assembly. The focus of this case study is the creation of a features that incorporate the design intent for the part.
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Design Intent (1/2) The Timing Chain Cover must meet the following design intent requirements: This part would most likely be manufactured through a casting process, which requires draft. Bosses of all holes (A, B, C, D) must be drafted.



B



D



C



• Create a draft feature on all the bosses. A



External extremity of ribs must be 1mm below the rim surface. Create reference points 1mm below the rim surface and constraint stiffener profile to these points.



Rim surface



Rib thickness must be 6mm.
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Create stiffener of thickness value of 6mm.
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Design Intent (2/2) The Timing Chain Cover must meet the following design intent requirements (continued): Large hole A must be supported by five ribs, hole B must be supported by four ribs, and hole C must be supported by one rib.



B C



Create stiffener features around holes.



Define tap on hole D.



A



Taps can be represented simply without needing to create the complex geometry, which can be time consuming and resourceintensive during regeneration cycles.



Copyright DASSAULT SYSTEMES



D



Copyright DASSAULT SYSTEMES



5-4



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Stages in the Process



Student Notes:



The following steps will be used to create the Timing Chain Cover:



Edit feature.



2.



Apply a draft.



3.



Create reference geometry.



4.



Create profile for stiffener.



5.



Create a stiffener.



6.



Create threads and taps.
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1.
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Apply a Draft In this section you will learn about drafts and how to apply different types of drafts to a part.



Use the following steps to create the Timing Chain Cover: 1. Apply a Draft.



Create a Stiffener. Create Threads and Taps. Edit Features.
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2. 3. 4.
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What is a Draft? (1/2) Draft features apply an angle to a part surface relative to some reference. Material is added or removed depending on the draft angle and pulling direction. The pulling direction is a term used because this functionality is primarily defined on molded parts. The draft on a part is designed to allow these molded parts to be easily removed from the molds.



A



Three types of drafts can be created within CATIA: B



A. Basic draft B. Reflect draft C. Variable draft



Conf. Dep. Conf. Dep. Conf. Dep.



A



B



C



Conf. Dep.
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What is a Draft? (2/2) A



A basic draft requires three criteria to be defined:



c



A. Pulling direction: The pulling direction is defined as the direction from which the draft angle is measured. It is the direction in which sides of a mold are pulled, while extracting a mold.



B



B. Draft angle: The draft angle is the angle that the draft faces make with the pulling direction with reference to the neutral element. This angle can be defined for each face.
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C. Neutral element: The neutral element is used to define the pivot hinge for the drafted surfaces. The drafted surfaces pivot about a neutral curve, the hinge, where it intersects the neutral element. The neutral element, usually a plane or face, can be the same reference used to define the pulling direction.
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Basic Drafts (1/2) To create a basic draft, you need to define the following: Faces to be drafted Neutral element Pulling direction When you select a reference to be the Neutral Element, CATIA automatically uses the same reference for the Pulling Direction.



1



Conf. Dep.



Use the following steps to apply a draft: 1. Select the Draft Angle icon. 2. Select the faces to which draft will be applied.



3 2
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3. Specify an angle value.
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Basic Drafts (2/2) Use the following steps to apply a draft (continued):



4



4. Specify the Neutral Element. 5. Specify the Pulling Direction. 6. Click OK.
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Conf. Dep.
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Reflect Draft (1/2)



Student Notes: Conf. Dep.



Drafts can also be applied to surfaces that are not planar, such as cylinders. They can also be created based on the reflect lines generated for a surface in a particular direction.



1



Use the following steps to apply a reflect draft:



1. Click the Reflect draft icon. 2. Select the surface to which you want to apply the draft. 3. CATIA automatically shows the default pull direction. To specify another direction, click on the Pulling Direction field and select a new reference. 2
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4. CATIA calculates the reflect lines based on the pull direction.
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Reflect Draft (2/2)



Student Notes: Conf. Dep.



Use the following steps to apply a reflect draft (continued): 5. In this particular example, the draft could be created indefinitely, therefore, a limit needs to be set. Click the More button and select the particular plane as a parting element.



5



6. Select Preview.



7



6



7. Click OK to complete the feature.
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Variable Draft (1/2)



Student Notes: Conf. Dep.



In certain situations, you may need to create a draft that has different angles at the transition edges. This can be accomplished using a variable draft. 1



Use the following steps to create a variable draft: 1. Click the Variable Draft icon. 2. Select the face on which the draft must be applied. 3. Select the neutral element.
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3
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2
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Variable Draft (2/2)



Student Notes: Conf. Dep.



Use the following steps to create a variable draft (continued): 4. CATIA determines the transition areas that can have different draft angles. They appear on the model and can be edited by doubleclicking the dimension.
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5. Click OK to complete the feature.
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Selecting Faces to Draft A



Draft features can be created on:



Conf. Dep.



A. Multiple faces: In this example, one draft feature is applied to the four side faces.



Conf. Dep.



B. Individual faces: In this example, four separate draft features are created for each of the four side faces. B



Conf. Dep.
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Conf. Dep.
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Using the Draft Analysis Tool Draft Analysis tool identifies zones (using color codes) and highlights areas which deviate from the specified values along a defined draft direction.



2



1



Use the following steps to perform Draft Analysis: 1. Set the customized render style.



3



2. Select the part you want to analyze. 3. Click the Draft Analysis icon. 4. Set the analysis to Quick analysis mode 5. Adjust the Draft direction to Z direction using the compass.



4



Observe the color ranges: Green: Draft value above 5 deg
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Blue: Below 0 deg Red: 0 – 5 deg In an ideal part, the analysis results in two color zone (Red and Blue) meet at parting line signifying two halves of a mold.
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Recommendations for Drafts



Student Notes:
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You will learn about specific methods and recommendations for draft features.
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Parting and Neutral Elements Whenever possible, use the same reference for the parting and neutral elements. Doing so can often avoid unexpected geometry. In the example below, two drafts are created using the common parting element but different neutral elements, because of this, their transition area produces unsatisfactory geometry. ORIGINAL PART



DRAFTED PART NEUTRAL ELEMENT



PARTING ELEMENT



NEUTRAL ELEMENT



Copyright DASSAULT SYSTEMES



UNSATISFACTORY GEOMETRY
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Expanding the Draft dialog box enables you to use the same reference for the Parting and Neutral Elements.
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Create Fillets After Drafts In order to control the fillet radius value and maintain a constant radius, a draft feature must be created before a fillet feature.



1



In the example shown, 1. The design intent requires that the value of each edge fillet remains constant throughout the design and development of the part. 2. If a draft is applied on a filleted surface, fillet values do not remain constant.



1
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Dress-Up Feature Order Whenever possible, create parts in the following general order: 1. Main part features (e.g., pads, pockets, shafts) 2. Drafts 3. Fillets 4. Shells 2



1



3
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Create a Stiffener In this section, you will understand what is a stiffener feature and how to create it.



Use the following steps to create the Timing Chain Cover: 1.



Apply a Draft.



3. 4.



Create Threads and Taps. Edit Features.
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2. Create a Stiffener.
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Introduction to Stiffeners Stiffeners in CATIA are created by extruding and thickening an open sketched profile.



A



They can be created in two ways: A. From side The sketch is extruded in the profile plane and thickened normal to it.



B. From Top The sketch is thickened in the profile plane and extruded normal to it.
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B



Copyright DASSAULT SYSTEMES



5-22



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Creation of Stiffeners (1/2)



Student Notes:



Stiffeners can be created using techniques other than the Stiffener feature. For example the Pad feature can be used to obtain the same result in certain cases. A stiffener feature is created from an open line, however, closed lines are preferred in the creation of solids When a stiffener is created, the ends of the open line are projected on to the nearest face of the active body. If this face disappears due to subsequent modifications then the function will fail and an error message will be displayed.
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If the same kind of geometry is created with a pad feature then an identical modification may give an incoherent result but the result will be visible and the modification to be carried out will be easy to see.
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Creation of Stiffeners (2/2)



Student Notes:



In the example, the lengths of the angled faces are reduced.
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For the case of the Stiffener.1 feature, the ends of the open line are no longer projected on to the nearest face of the Pad.1 feature. The function will fail an error message will be displayed.



For the case of the Pad.3 feature, the limits of the feature are the outer faces of the Pad.2 feature. The result will not be coherent but it’s visible and corrective action will be easy to determine.
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Recommendations for Stiffeners



Student Notes:
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In this section, you will be given a recommendation to help during the creation of Stiffeners.
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Alternative Methods for Creation of Stiffeners Pad



A stiffener is created by the projection of the limits of an open sketch on to the nearest faces of the active body. The feature must fully intersect the supporting faces. If, after a modification, the stiffener feature no longer fully intersects the supporting face then the part update will fail. Modifications can affect any of the following:



(Closed line)



Stiffener (Open line) A



A. A supporting face.



B



B. The stiffener feature geometry. C. The position of the stiffener feature.



C
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Consider using the Pad tool as an alternative method for creation of stiffeners. For the same geometry the Pad tool uses a closed sketch. A closed line is more stable and modifications are less likely to result in update errors.
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Exercise: Stiffeners and Draft



Student Notes:



Recap Exercise 20 min



In this exercise you will create a part that will contain stiffeners and a draft feature. Detailed instructions for this exercise are provided. By the end of this exercise you will be able to: Create stiffeners
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Create a draft
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Do it Yourself (1/6) 1. Create a new part. To create a new part file, select Part from the New dialog box. a. b. c. d.



Click File > New. Choose Part from the New dialog box. Click OK. Specify a part name [Ex5A] and click OK.



1d 2a



2. Create a pad. You will create a positioned sketch of the shown profile and use that to create a pad feature. Click the Positioned Sketch icon. Select YZ plane as the sketch reference. Sketch the profile. Constrain the sketch. Exit the sketcher. Create the pad.



2f
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a. b. c. d. e. f.
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Do it Yourself (2/6) 3. Shell the part. a. b. c. d.



3a



Click the Shell icon. Select the indicated face to remove. Type [5mm] as the inside thickness. Click OK.



3b



3c
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3d
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Do it Yourself (3/6)



4c



4. Create a stiffener. The stiffener is created between two perpendicular faces. The From Side mode is used. a. b. c. d. e. f. g. h. i.



Click the Positioned Sketch icon. Select the zx plane. Create the following sketch. Exit sketcher. Click the Stiffener icon. Select Sketch.2 as the profile reference. Verify that the mode is From Side. Type [6mm] as the thickness1. Click OK. 4g
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4h
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4e
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Do it Yourself (4/6) 5. Create a stiffener. The stiffener is created by offsetting from a reference. The From Top mode is used.



5c
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a. Create an offset plane. b. Create a positioned sketch on the offset plane. c. Create the following sketch. d. Exit the sketcher. e. Click the Stiffener icon. f. Select Sketch.3 as the profile reference. g. Verify that the mode is From Top. h. Type [6mm] as the thickness1. i. Click OK.



5a
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Do it Yourself (5/6) 6. Create a pad. This feature is created as a pad to demonstrate that the stiffener geometry can be created by other means. This usually involves more steps. Click the Positioned Sketch icon. Select the ZX plane. Create the following sketch. Exit sketcher. click the Pad icon. Select Sketch.4 as the profile reference. Type [3mm] as the thickness1. Click the Mirrored extent option. Click OK.



6c



Copyright DASSAULT SYSTEMES



a. b. c. d. e. f. g. h. i.
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Do it Yourself (6/6) 7. Create a draft.



7a



a. Click Draft icon. b. Select the four outer faces to draft. c. Select the top surface as the neutral element. d. Type in [10deg] as the angle. e. Click OK.



7b



8. Close the file without saving it.



7c 7b
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7d
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Exercise Recap: Stiffeners and Draft



Student Notes:
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Create stiffeners Create a draft
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Exercise: Drafts



Student Notes:



Recap Exercise 20 min



In this exercise you will practice creating drafts. High-level instructions for this exercise are provided. By the end of this exercise you will be able to: Create a basic draft
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Create a reflect draft
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Do it Yourself (1/5) 1. Create a new part. Create a new part with the geometrical set.



1



2. Create a shaft. You will create a sketch of the shown profile and use that to create a pad feature. a. Create the sketch on the YZ plane. b. Create a 360°shaft feature.
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2
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Do it Yourself (2/5) 3. Create a basic draft.



3
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a. Select the walls of the cylinder as the faces to draft and the top surface as the neutral and pulling direction. b. Enter a [6deg] draft angle.
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Do it Yourself (3/5) 4. Create a Reflect draft. a.



b. c. d. e. f.



Create an offset datum plane that is [100 mm] from the XY plane in the negative direction. Select the face of the cylinder to apply the reflect draft. Click OK to the Feature Definition Error. Define the parting element as the offset plane created earlier. Define the pulling direction as the offset plane created earlier. Ensure the pull direction is correct.



4b 4f



4c



4d Copyright DASSAULT SYSTEMES



4e
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Do it Yourself (4/5) 5. Create a pocket. a. Select the top surface of the pad and sketch the following profile. Use the existing edge of the pad to create a [10mm] offset. b. Create a pocket that is [50mm] deep.



5a
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5b
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Do it Yourself (5/5) 6. Create an edge fillet. a.



Select the edges around the entire top and bottom profiles and specify a [5mm] radius value.



7. Hide all the references plane. 8. Close the file without saving it.
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Exercise Recap: Drafts



Student Notes:
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Create a basic draft Create a reflect draft
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Exercise: Stiffeners and Draft



Student Notes:



Recap Exercise 10 min



In this exercise you will use the new skills you have acquired to create a part that contains a draft and four stiffeners. You will use the tools used in the previous exercises to complete this exercise with no detailed instructions. By the end of this exercise you will be able to: Create a new part Apply draft to a part
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Create stiffeners
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Do it Yourself Create the part shown below.
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1.



Student Notes:



Copyright DASSAULT SYSTEMES



5-43



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Exercise Recap: Stiffeners and Draft



Student Notes:



Copyright DASSAULT SYSTEMES



Create a new part Apply draft to a part Create stiffeners
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Create Threads and Taps In this section, you will learn how to create threads and taps.



Use the following steps to create the Timing Chain Cover: 1. 2.



Apply a Draft. Create a Stiffener.



4.



Edit Features.
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3. Create Threads and Taps.
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What are Threads and Taps? (1/2) A thread is a helical groove outside of a cylindrical shaft, while a tap is a helical groove inside a cylindrical hole.



In CATIA, the actual geometry of the threads and taps is not displayed. It is represented on the part cosmetically. The features contain parameters that define the intended thread and tap geometry, such as diameter, pitch, and depth.



Tap



CATIA representation
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Thread



CATIA representation
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What are Threads and Taps? (2/2) The Thread/Tap Definition dialog box enables you to specify the following: A. The surfaces on which the thread or tap is placed. B. The start surface of the thread or tap. C. CATIA already has two standards. You may add a customized one by selecting the Add button.



A B



D. Characteristics of the thread/tap may differ depending on the standard that is applied.



C
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Thread and Tap (1/2) Use the following steps to create a thread/tap:



1



1. Click the Thread/Tap icon.



2



2. Select the Lateral Face on which the thread will be grooved.



3



3. Select the Reference Face from which the thread will begin. 4. In this example, Metric Thin Pitch is selected as the thread standard. 5. Select the thread diameter. 6. Specify a value in the Thread Depth field.



4 5
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6
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Thread and Tap (2/2) Use the following steps to create a thread/tap (continued):



7



7. Click the Preview button in the dialog box. 8. Click OK to complete the thread.



8
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The thread or tap geometry does not appear on the model, but does in the specification tree. It can also be displayed in a drawing view.
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Edit Features In this section you will learn how to edit features.



Use the following steps to create the Timing Chain Cover: 1. 2. 3.



Apply a Draft. Create a Stiffener. Create Threads and Taps.
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4. Edit Features.
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Editing Features



Student Notes:



Feature editing and manipulation, beyond dimension changes, is often required as the design intent changes or modeling strategies evolve. CATIA has several tools that enable you to edit features, some of them are listed below: Define In Work Object



•



Reordering features



•



Properties



•



Filters (Search)



•



Hide/Show features



•



Parent-child relationships



•



Deactivate/Activate features



•



Resolving feature failures
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•
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Model View Options Several options are available in CATIA to simplify your display. Two of the most common methods of simplification are Hide/Show and Deactivate/Activate. Hide reference planes and sketches



Deactivate hole features



Show



Deactivate



Activate
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Hide
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Hide/Show (1/2) Wireframe and surface geometry (such as sketches, and reference planes) can be removed from display to help simplify the display.



A



You can hide/show elements using a number of methods:



B



A. Right-click on the element(s) in the specification tree or directly on the model and click Hide/Show from the contextual menu. B. Select the element(s) and click the Hide/Show icon.



C
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C. To hide/show all elements of the same type you can also use the Tools > Hide or Tools > Show menu.
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Hide/Show (2/2) CATIA has two visual spaces: visible and invisible. Objects that can be seen are in the visible space, while objects that cannot be seen are in invisible space.



A



You can determine which visual space an element is in using one of the following methods: A. Hidden elements are displayed in the specification tree dimmed.



B
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B. Click the Swap Space icon. This places you in the invisible working space. All hidden elements are shown and all shown elements are hidden. To return to visible space, click the Swap Space icon again.
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Investigating the Model (1/2)



Student Notes:



CATIA has tools available that can help you to investigate a model. These tools can be used to determine how a model was made, and to check the types of parent/child relationships that exist. The Specification tree
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As you create features the specification tree is populated. Use the specification tree to determine how a model was made. Features are added to the tree in the order of creation. Children cannot exist in the tree before their parents. For example, the first feature in the specification tree on the right is a pad. Move your pointer over the pad in the tree to highlight the pad in the model.



The specification tree is also useful while making selections. Rather than selecting features directly on the model (which can sometimes be difficult), it is easier to highlight the features using a specification tree.
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Investigating the Model (2/2)



Student Notes:



Model Scan Model Scan helps you to review the creation of a model, one feature at a time. You can use this tool to see a step-by-step replay of how a model (made by another designer) was created. To use the Model scan, click Edit > Scan or Define In Work Object. Parent/Child
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The Parent/Child tool displays all the parents and children of a selected feature. You can use this tool to check the different types of relationships that exist in a model. To use the Parent/Child tool, right-click on the feature and select the Parent/Children command.



Copyright DASSAULT SYSTEMES



5-56



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Parent-Child Relationships



Student Notes:
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The references that exist between the features, either through the process of creation or by association, are called parent-child relationships. To view a feature’s parent-child relationship, select the feature in the specification tree, right-click to open the contextual menu, and select Parents/Children. The Parents and Children window opens, showing the feature and its references. Features on the left are parents, while features on the right are its children.
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Why Reorder Features? The order in which the features and operations appear in the specification tree affect the geometry of the part. Changing the order is sometimes necessary because features have been created in the wrong order or perhaps the design intent has changed.



Copyright DASSAULT SYSTEMES



In the picture below shown on the left, a hole was created after a mirror operation. Reordering the hole to come before the mirror, gives the result as shown on the right.



One Hole
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Two holes when moved before the mirror operation
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Reordering Features (1/2) Use the following steps to reorder a feature: 1. Select the feature(s) to be reordered and right click. 2. Click Reorder from the contextual menu.
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Reordering Features (2/2) Use the following steps to reorder a feature (continued): 3. Select the feature after which you want to place the features to be reordered. 4. Click OK.



3 4



Copyright DASSAULT SYSTEMES



3



Copyright DASSAULT SYSTEMES



5-60



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Limitations on using Reorder
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When one feature is referenced by another during a design, a parent-child relationship is established between the two. This means that the second feature (i.e., the child) is dependant on the first (i.e., the parent) for a part of its definition. In the example below, the sketch for the small pocket is constrained to the large pocket. If you attempt to reorder the small pocket before the large pocket, CATIA prompts a message that this action is not possible. Had this feature been reordered, you would have received an update cycle error due to the circular reference.
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Define In Work Object (1/2)
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As shown previously, the order of the features can affect the outcome of a model. Feature creation is not only dependent (in terms of design intent) on the features created before it, but also on the features created after it. Therefore, sometimes it is necessary to create features at earlier states of the model, instead of where it is currently. This is accomplished by defining the correct work object. When a feature is set as the work object, all the features that were created after it are ignored, and the model is in the state when that particular feature was created.
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To set a feature as the work object, select it and right-click to open the contextual menu, then select Define In Work Object.
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Define In Work Object (2/2) The current work object is underlined in the specification tree. In this example, Pocket.2 is the work object and all the features before it are active. By setting the work object to particular features, the model can be captured at various stages of design. A. In this case, the Shaft.1 feature is the work object. Therefore, only the shaft feature is visible because there are no features before it. Pocket.2 is the work object. All features exist.



B. In this case, the Hole.1 feature is the work object. Therefore, all other features except Pocket.2 are visible. In order to get the main shape of the part:



A



B
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1. Define the main container as the work object before saving the document. 2. Ensure that the PartBody and the final Geometric Set are active before saving.
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Deactivate/Activate



Student Notes:



The Deactivate option temporarily removes the features from the update cycle of the model. The features can be activated again when needed. You can deactivate the features by right-clicking on the feature in the specification tree or directly on the model and clicking X.Object > Deactivate.
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When you deactivate a feature, children of that feature must also be deactivated. Children are defined as features that depend on another feature (the parent) to exist. For example, if the pad feature shown below is deactivated, the fillet and the hole must also be deactivated. The hole requires the face of the pad to exist, while the fillet requires the edge of the pad to exist.
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Resolving Feature Failures (1/4)
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Creating or modifying features can sometimes result in feature failures. There are various reasons for the failure of features; generally it happens due to references being lost during modifications or because the geometry cannot be generated the way it is currently defined. When a feature fails due to reasons other than the inability to create geometry, an Update Diagnosis dialog box appears that gives information on why the failure has occurred. CATIA gives you the option to either edit the failed feature, deactivate it, isolate its references, or delete it.
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Resolving Feature Failures (2/4) In the example shown here, the edge fillet needs to be deleted because it is no longer necessary. Use the following steps to resolve a feature failure:
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1. Select the EdgeFillet feature, right-click and select Delete. 2. In the delete window, make sure the Delete all children option is not selected, since you do not want to remove anything except the edge fillet. 3. Click OK.
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2



3
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Resolving Feature Failures (3/4) Use the following steps to resolve a feature failure (continued):



4



5 8 7
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4. Once the feature is deleted, all the features after EdgeFillet.1 are shown as non-updated in the specification tree. The non-updated features are identified by an update symbol. 5. The Update All icon is highlighted in the Tools toolbar. 6. The model appears in red to show that it is not fully updated. 7. The Update Diagnosis window appears. It indicates a problem with Sketch.2, and that an edge is no longer recognized. 8. Click the Edit button.
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Resolving Feature Failures (4/4) Use the following steps to resolve a feature failure (continued):



Missing reference



The sketcher environment is opened to edit Sketch.2. 10. Review the sketch and notice that the hole placement was dimensioned to the edge which has been removed by the fillet. The hole placement reference was also deleted when the edge fillet was deleted. 11. Delete and recreate the dimension to an existing edge and exit the sketcher. The failure is resolved.
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9.
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Properties (1/4)
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The appearance and function of features can be customized using the Properties command. It can be accessed by selecting the feature and clicking Edit > Properties, or by right-clicking on the feature and selecting properties in the contextual menu. The properties of a feature are split into three tabs: • Mechanical Feature properties



•



Graphic
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•
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Properties (2/4)
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Mechanical The Mechanical tab gives you information about the update status of the feature. The Deactivated option is the only one you can set manually. This option essentially suppresses the feature such that, it does not get evaluated during regeneration. By setting this, you can also apply this property to impacted elements.
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The Associate stop update option allows you to stop the update of this feature and displays a custom message. This is useful when you are modifying other areas of the part and want this feature to be updated only in certain conditions.
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Properties (3/4)



Student Notes:
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Feature Properties The Feature Properties tab enables you to give the feature a custom name. This tab displays information regarding who created the part, when it was created, and when it was last modified.
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Properties (4/4)



Student Notes:



Copyright DASSAULT SYSTEMES



Graphic Within the Graphic tab, you can customize the color, thickness, and line type of various entities of the feature. You can also specify the layer (used to filter out graphics) properties and how the feature behaves with respect to them.
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Search (1/4)
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In a complex part with a large quantity of features, it can be challenging to locate particular items to edit or modify them. CATIA enables you to search for particular items using a variety of criteria. To access the functionality, click Edit > Search. The search window contains three tabs that define three types of search methods: • General Advanced



•



Favorites
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Search (2/4)
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General The General tab enables you to search using one of the three methods: • Name • Searches the model for the feature. You may also use the asterisk (*) wildcard and set the search to be case sensitive. For example (Connector*) looks for all the feature names that begin with “Connector”.



• Type • Searches the model for a particular feature type associated to particular workbench. For example (Part Design – Pad).



• Color
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• Searches the model for items that have a particular color.
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Search (3/4)
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Advanced • The Advanced tab enables you to use the same searching techniques that are found in the General tab; however, you can combine them into more complex Boolean expressions. • To create the query shown, select the workbench, type, and attribute. Then click the And icon and select another set of criteria. Also note that it is not mandatory to fill all the three fields; you can create the query using any combination of the fields.



Copyright DASSAULT SYSTEMES



5-75



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Search (4/4)
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Favorites • The searches conducted within the General and the Advanced tabs can be saved to a favorites list. Once a search is run, the Add Favorites icon is selectable and you have the option of giving it a custom name. Once added, it appears in the main window of the Favorites tab.
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In this section, you will be given a recommendation to assist while deactivating features and while investigating a model.
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No Deactivated Feature in Loaded Document (1/2)



Student Notes:



It is recommended not to keep deactivated features in a document to be saved. Whilst it is possible that a document in progress may have deactivated the features, the final released document must NOT have any unnecessary features. Pay particular attention to a complex part with deactivated features. 1.



In the example shown, EdgeFillet.1 is positioned just after Pad.1. It could be less visible than the other four deactivated features, which are grouped at the bottom of the tree. a.



Activate the last four features in the tree.
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No Deactivated Feature in Loaded Document (2/2)



b.



It could then appear that the fillet at both the top corners is missing.



c.



Create a new fillet on these two edges to improve the design. On a later occasion, the deactivated fillet, EdgeFillet.1 is identified and reactivated. An error message will be displayed.



d.



Student Notes:



1b



1c



1d
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2.



This scenario could occur in a more complex part. It would further lead to an update error along the design cycle.
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Design Practices
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When modeling in CATIA, it is important to understand that the steps you take to achieve the creation of the model are as important as the end result. You should carefully consider choosing the best base feature, what parent/child relationships should or should not exist, and what dimensions and feature order best reflect the intended design intent. Many design practices are derived from company standards and need to be considered before modeling is started. Some common design practices are: Try to avoid creating references to dress-up features such as fillets and chamfers. These features many be removed in downstream applications. Always use positioned sketch when creating a sketched profile.
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Always choose the most stable feature in the model as the base feature. Choose the best depth option for the application. For example, decide if a pocket is required to always cut through the entire model. Creating the pocket with a dimensional depth is not recommended, because the depth of the feature it is cutting through may change; instead, create the pocket with an Up to Last depth.
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To Sum Up
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In the following slides you will find a summary of the topics covered in this lesson.
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Apply a Draft
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Draft features are used to apply an angle to a part surface relative to some reference. Material is added or removed depending on the draft angle and the pull direction applied during the operation. Whenever possible, use the same reference for the parting and neutral elements. Doing so can often avoid unexpected geometry. Whenever possible, create parts in the following general order: 1. Main part features 2. Drafts 3. Fillets 4. Shells
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5. Minor part features
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Create a Stiffener
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In CATIA, stiffeners are created by extruding and thickening an open-sketched profile. A. From Side The sketch is extruded in the profile plane and thickened normal to it.
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B. From Top The sketch is extruded normal to the profile plane and thickened in the profile plane.
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Create Threads and Taps A thread is a helical groove outside of a cylindrical shaft, while a tap is a helical groove inside a cylindrical hole. In CATIA, the actual geometry of threads and taps is not displayed. It is represented on the part cosmetically. The features contain parameters that define the intended thread and tap geometry, such as diameter, pitch, and depth. It can also be displayed in a drawing view.



Tap



Thread



Edit Features
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Feature editing and manipulation, beyond dimension changes, is often required as design intent changes or modeling strategies evolve. CATIA has several functionalities that enable you to edit features. Define in work object Reorder features Properties Filters (Search) Parent-child relationships Resolve feature failures



Copyright DASSAULT SYSTEMES



5-84



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features Student Notes:



Main Tools Dress-Up Features 1



1



Draft Angle: Creates a basic draft.



2



Draft Reflect Line: Creates drafts on nonplanar surfaces, such as a cylinder.



2



Variable Angle Draft: Creates a draft that has different angles at transition edges.



3



Thread/Tap: Applies threads or taps on shafts or holes.



4



3



4



Sketch-Based Features Stiffener: Creates a stiffener by extruding and thickening an open-sketched profile.



5
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Exercise: Features Deactivation
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Recap Exercise 10 min



In this exercise you will open an existing part that contains a completed model. You will use the tools learned in this lesson to investigate how the model was created, and to simplify the model display. Detailed instructions for this exercise are provided. By the end of this exercise you will be able to: Read a specification tree Scan a model history Hide/Show elements Swap visual workspace
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Investigate Parent/Child relationships
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Do it Yourself (1/6) 1. Load Ex3D.CATPart.



2. Review the specification tree. The first step in understanding how a model was created is to expand the model tree and review the features. a. b.



2a 2b



Copyright DASSAULT SYSTEMES



c.



Click the + symbol beside the PartBody to expand the PartBody node. Move your pointer over the features in the tree. Observe that the features are highlighted on the model and in the tree. Review the order in which the features were created.
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Do it Yourself (2/6) 3. Review the construction history of the model. To understand the design intent of the model, use the Scan tool to review its development. a. b. c.



d.



e.



3d



3f



3c
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f.



Click Edit > Scan or Define in Work Object. Click the First icon to rewind the construction to the beginning. Observe that the first feature in the model is now underlined in the Specification tree. This indicates that it is the active feature. None of the features below the underlined feature are currently active. Click the Next icon to review the development of the model. Observe that the next feature in the model is now underlined in the specification tree. Continue to click the Next icon until the model is complete. Click the Exit icon to close the scan.



3b



Copyright DASSAULT SYSTEMES



5-88



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features Student Notes:



Do it Yourself (3/6) 4. Hide the default reference planes. To simplify the screen, hide all wireframe and reference geometry. a. From the specification tree select all the three default reference planes. b. Right-click and select Hide/Show from the contextual menu.



4b



5. Hide all sketches from display. To simplify the display, hide all the sketches.
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a. Click Tools > Hide > All Sketches.
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Do it Yourself (4/6) 6. Change the visual space. Verify which elements have been hidden from display by temporarily swapping the visual space.



6b
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a. Click the Swap Visible Space icon to view the invisible space. b. Observe that only the sketches and default reference planes are displayed. c. Click the Swap Visible Space icon again to return to visible space.



6a
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Do it Yourself (5/6) 7. Deactivate a feature. A co-worker is unable to deactivate an edge fillet from the model without deactivating other features that are required. Determine why the required feature is being affected. a. Right-click on EdgeFillet.7 and click Deactivate. b. Review the Deactivate dialog box. Observe that two hole features will also be deactivated. c. Click Cancel. d. Right-click on Hole.11 and select Parent/Children.



7a
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7d



Copyright DASSAULT SYSTEMES



7c



5-91



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features Student Notes:



Do it Yourself (6/6) 7. Deactivate a feature (continued). e. Hole.11 has no children; however, its parent is Hole.10. Double-click on Hole.10 to explore its parents. f. Observe that Hole.10 is dependent on a number of features. One of parents of Hole.10 is the edge fillet that needs to be deactivated. This relationship will need to be broken before the edge fillet can be deactivated. g. Click OK.



8. Save and close the model.



7e



7f
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Exercise Recap: Features Deactivation



Student Notes:



Review a specification tree Scan a model history Hide features Swap visual workspace
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Investigate parent/child relationships
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Exercise: Features Activation



Student Notes:



Recap Exercise 10 min



In this exercise you will open an existing part and investigate how it was modeled. High-level instructions for this exercise are provided. By the end of this exercise you will be able to: Review the specification tree Hide features
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Activate features
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Do it Yourself (1/2) 1. Load Ex3E.CATPart.



2. Review the specification tree. Review the specification tree and note the hidden and deactivated features. 3
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3. Hide the default reference planes. The reference planes are no longer required to simplify the display. Hide them from visible space.
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Do it Yourself (2/2) 4. Activate the edge fillets. The last three features in the specification tree have been deactivated. Activate these features. 5.



Close the model.
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Exercise Recap: Features Activation
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Review a specification tree Hide features
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Activate features
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Exercise: Thread and Tap
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Recap Exercise 20 min



In this exercise you will create a new part, a thread/tap feature, reorder some features according to the design intent, and modify feature properties. Detailed instructions for this exercise are provided. By the end of this exercise you will be able to: Create a thread/tap Reorder a feature
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Change the properties of a feature
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Do it Yourself (1/11) 1. Create a new part. To create a new part file select Part from the New dialog box. a. Click File > New. b. Choose Part from the New dialog box. c. Click OK. d. Specify a part name [Ex5D] and click OK.
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2. Create pad features. Create two positioned sketches and use that to create two pads. a. Click the Positioned Sketch icon. b. Select YZ plane as the sketch reference. c. Sketch the profile and exit the sketcher. d. Sketch another positioned sketch on YZ plane. e. Exit the sketcher.
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1c



2a



2c 2d
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Do it Yourself (2/11) 2. Create a pads (continued…).



2g



2i



2g



2i
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f. Click the Pad icon. g. Set sketch.1 as profile to create first pad. Type [15mm] as length. h. Click the Pad icon. i. Select sketch.2 as profile to create second pad. Type [40mm] as the length.



2f
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Do it Yourself (3/11) 3. Create a Shell. In order to create a shell we need to define a thickness and faces that are to be removed. a. b. c. d.



3a



Click the Shell icon. Type [4mm] as the inside thickness. Select the surfaces to remove. Click OK.



3b



3d



3c
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3c
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Do it Yourself (4/11) 4. Create a pocket. In order to create a pocket, you need to define a sketch to extrude. a. Click the Positioned Sketch icon. b. Select the following surface. c. Sketch and constrain the following profile. d. Exit the sketcher.



4a



4b
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4c
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Do it Yourself (5/11) 4. Create a pocket (continued…). e. Click the Pocket icon. f. Specify the definition values shown. g. Click OK.



4e



4f
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Do it Yourself (6/11) 5. Create an edge fillet. An edge fillet is created by defining edges and a radius value. a. b. c. d.



Click the Edge fillet icon. Select the edges. Specify [5mm] as the radius value. Click OK.



5a 5b
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5c
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Do it Yourself (7/11) 6. Create a thread/tap. Threads and taps are not visually represented in the 3D environment; however, the feature will appear in the specification tree after creation.



6a



a. Click the Thread/Tap icon. b. Select the following surface as the lateral face. c. Select the following surface as the limit face. 6b
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Do it Yourself (8/11) 6. Create a thread/tap (continued). d. Type [15mm] as the thread depth value. e. Click Preview. f. Click OK.



6d



6e
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Do it Yourself (9/11) 7. Reorder the shell feature. After reviewing the model, the pocket created must extend to the back of the part. Therefore, the pocket feature must be applied before the shell. a. Select the shell feature in the tree, right-click and select Reorder. b. Select the Pocket.1 feature. c. Click OK.
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7a



7b 7c
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Do it Yourself (10/11) 8. Modify feature properties. To customize the display of the features created, you can modify their individual properties. a. Select the Pad.1feature from the specification tree, right-click, and select Properties. b. Select the Feature Properties tab. c. Specify [Base] as the Feature Name. d. Click OK.



8b 8c
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Do it Yourself (11/11) 8. Modify feature properties (continued). e. Select the PartBody feature and rightclick, and select Properties. f. Select the Graphic tab. g. Change the fill color (as shown). h. Click OK.



Close the file without saving it.
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9.
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8h



5-109



CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Exercise Recap: Thread and Tap
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Create a thread/tap Reorder a feature
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Change the properties of a feature
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Exercise: Feature Failures
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Recap Exercise 10 min



In this exercise you will open an existing part that contains a pad and hole. You will change the profile of the pad, update it, and resolve any feature failures that may occur. High-level instructions for this exercise are provided. By the end of this exercise you will be able to:
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Troubleshoot a part that contains features that fail.
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Do it Yourself (1/3) 1.



Load Ex5E.CATPart. 1



2.



Change the profile of the pad. Edit the sketch.1 of Pad and change it as shown:
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Do it Yourself (2/3)



3
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3. Resolve feature failures. Once CATIA tries to regenerate Hole.1, sketch.3 fails. CATIA prompts you to edit the sketch. Review the sketch and notice the missing references. Delete them, recreate them and exit the sketcher workbench.
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features Student Notes:



Do it Yourself (3/3) 4. Resolve feature failures (continued). You still have a failure on Hole.1. Review the feature and notice the support of hole (face.1) is missing. a. Edit Face.1 and select the correct support. 4



4a



Close the file without saving it.
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5.
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Exercise Recap: Feature Failures



Student Notes:
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Troubleshoot a part that contains features that fail.
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Exercise: Feature Failures



Student Notes:



Recap Exercise 10 min



In this exercise you will open an existing part. You will delete a dress-up feature, verify the impact and correct the update errors. You will use the tools you have learned in this lesson to complete the exercise with no detailed instruction.



By the end of this exercise you will be able to:
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Use Parents/Children relationship. Troubleshoot a part that contains features that fail.
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features Student Notes:



Do it Yourself 1. 2. 3.



Load Ex5F.CATPart from database. Study the impact of deletion of Chamfer.6 by Parents/Children. Delete Chamfer.6 and correct the update errors.
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Delete this chamfer
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Exercise Recap: Feature Failures



Student Notes:
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Use Parents/Children relationship Troubleshoot a part that contains features that fail
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features Student Notes:



Case Study: Dress-up Features Recap Exercise 25 min



In this exercise you will modify the case study model. Let us recall the design intent of this model: Bosses of all holes (A, B, C, D) must be drafted.



C



D



External extremity of ribs must be 1mm below the rim surface. Rib thickness must be 6mm.



B



Large hole A must be supported by five ribs, hole B must be supported by four ribs, and hole C must be supported by one rib.
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Define tap on hole D. A



Using the techniques you have learned so far, create the model without detailed instructions.
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Do It Yourself: Create the Timing Chain Cover



Student Notes:
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Search and load Exercise5-CaseStudy_Start.CATPart and add the features to the part using the drawing provided here.
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CATIA V5 Automotive - Body Lesson 5: Dress-Up Features



Case Study Recap: Timing Chain Cover



Student Notes:



Create reference geometry Create sketch profiles Create draft features Create stiffener features Create an edge fillet
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Create a tap feature
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features 

5A Low Dropout Positive Regulator. Analog Integrations Corporation. Si-Soft Research Center. DS-1084P-02 061804. 3A1, No.1, Li-Hsin Rd. I , Science Park ...
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Technical Features: Product Features 

With external high gain and low noise amplifier. Stylish and compact size design with Shiny black finish. Excellent reception for digital, freeview and analog TV signals. Powered by DTV set-top box or included separate power adapter. Specially Compat










 


[image: alt]





1 Features 

Cost effective alternative to a fossil fuel boiler ... The sound pressure level is measured via a microphone at 1m from the unit. It is a ..... Transformer 24V for PCB.
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Basic Features 

In this lesson you will learn how to create basic CATIA features. ... The case study for this lesson is the engine support used in the drill support assembly as.
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Basic Features 

Student Notes: CATIA V5 Automotive - Chassis Lesson 3: Basic Features ... The Timing Chain Cover is a part of the Powertrain sub-assembly. The focus of this ...










 


[image: alt]





Additional Features 

2a. 2b. 1. 3. Both options, Mirror and Symmetry, allow you to mirror the selected geometry about an axis. The Mirror .... element(s) and all elements that form a chain with it are offset. ...... you will construct a damper assembly cap. High-level ..
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Basic Features 

Student Notes: CATIA V5 Automotive - Powertrain Lesson 3: Basic Features ... The Timing Chain Cover is a part of the Powertrain sub-assembly. The focus of ...
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Key Features 

visualisation of all Dorna flag signals received through Dorna Transponder X2 CAN BUS ... Red Flag. Blue Flag. White Flag. White Flag with diagonal Red Cross.
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1 Features 

Cost effective alternative to a fossil fuel boiler ..... Optional electric heater has 2 capacity steps except for the 3V3 model which has only 1 capacity step. For 6W1 ...
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Main Features 

q Features an LCD screen for graphic display of the equalization setups stored in â€œMEMORY.â€� The screen has a handy backlit for use on stage and in dark ...
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Basic Features 

Basic Features. In this lesson you will learn how to create the basic CATIA features. ... The Timing Chain Cover is a part of the Powertrain sub-assembly. The.
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datasheet general features - RobotShop 

SOFTWARE COMPATIBILITIES. OS. PROGRAMMING LANGUAGES. Embedded Linux (32bit x 86. ELF) using custom OpenEm- bedded based distribution.
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features - Cinematography Mailing List 

The Digital Signal Processing (DSP) used in the camera sections allows the use of set-up ... camcorders, i.e. the '709 and the '790 now have 12 bit A/D converters and a new DSP ... Cards can be read or overwritten as many times as you like.
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Advanced Solid Features 

Create Ribs and Slots. Create Multi-sections Solid. Create Advanced Drafts. Advanced Solid Features. In this lesson you will learn how to create advanced solid ...
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Key Features and Benefits 

ComProbe is a registered trademark of ... ComProbe, Audio Expert System, BPA and the Frontline logo are trademarks, Debug Communications Faster! is a ...
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Oracle 11G New Features 

The SQL query result cache is an area of memory in the Shared Global Area ... the OCI client result cache can retain results from queries or functions on the.
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More Features CB-1 Features Package Includes ... - Midland Radio 

CB-1 Features. 4 Watt Output Power. The maximum power allowed to give you the greatest range of communication. Instant Channel 9. Immediate access to.
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general 1999 features - shinny.co.uk 

The brake specifications have been partially changed as indicated in the following table. ... Torque (SAE-NET) N.m / rpm (lb-ft@rpm) ... 60. 65. 70. Major Dimensions & V ehicle W eights. Performance. Engine ...... Applicable models: SXV23 Series ....
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KEY FEATURES KLE500 

Allows tighter engine clearances for quieter running. â–«. Auxiliary cooling fan helps maintain optimum coolant temperature for best performance, fuel economy ...
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SPOT FEATURES COMPARISON 

Replaceable Help/Emergency Button Covers. N/A. Yes. GPS LED Indicator. No. Yes. Message Sent LED Indicator. No. Yes. Additional Message Button. No. Yes.
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features - Cinematography Mailing List 

Press the dial and check the ID of the card is the one you want to read. ... To create your own set-up, align the camera the way you like it via the menus, either from .... You don't have to buy a 'widescreen' lens for shooting widescreen. ... Note: 
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BCX ULTRA FEATURES: 

and this can be seen thru our wide variety of apparatuses, ease of use, and ... The BCX Ultra gives you the ability to research and do your own testing. ..... wave gives the body a chance to recognize, make adjustments for, and eventually ignore ... 
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Dress-Up Features 

and Engine assembly shown below. The Timing Chain Cover is part of the Power Train sub-assembly. ... Large hole A must be supported by five ribs, ..... Detailed instructions for this exercise are provided. ..... and bottom profiles and specify a.
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datasheet general features - RobotShop 

ORIGINAL DESIGN. BASED ON: Hall effect sensors. dsPICS microcontrollers ... using custom OpenEm- bedded based distribution. C++, Urbi script, Python, .Net.
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